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Welcome to FileMaker Pro

 

Welcome to the FileMaker

 



 

 Pro application from Claris Corporation. 
FileMaker Pro is designed to help you manage information easily and 
effectively.

This installation guide, the 

 

FileMaker Pro User’s Guide

 

, and the onscreen 
Help system work together to give you the information you need to know as 
you learn about FileMaker Pro. 

For a complete description of what’s in the documentation set, see “Getting 
Help” in the 

 

FileMaker Pro User’s Guide.

 

About this guide

 

This 

 

FileMaker Pro Installation & New Features Guide

 

 includes 
instructions for installing the application on your hard disk.

 

1

 

Chapter 1, “Installing FileMaker Pro,” gives instructions for installing the 
application, registering your ownership, and everything else you need to 
do before you can use FileMaker Pro.

 

1

 

Chapter 2, “New features in FileMaker Pro,” provides an overview of the 
new features in FileMaker Pro 3.0. This chapter is especially helpful for 
users upgrading from previous versions of FileMaker Pro.

 

1

 

Appendix A, “Setting up the MacIPX control panel,” provides 
information on using MacIPX for networking.

 

Using this book

 

This guide presents special information in the following ways:

 

Descriptive heading

 

messages give extra information about a procedure.

 

Note

 

messages provide background or supplemental information.

 

Important

 

messages alert you to situations that require special attention, such 
as an action that you can’t undo.
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Getting customer support

 

To learn about Claris Technical Support and Claris Customer Assistance, 
their hours of operation, and their telephone numbers, see the 

 

Claris

 



 

 Service Directory 

 

included in the product package.



 

Chapter 1: Installing FileMaker Pro 

 

This chapter gives step-by-step instructions for installing the FileMaker Pro 
application and associated files on your Macintosh

 



 

 

 

computer.

 

Note

 

These instructions assume that you’re familiar with standard mouse 
techniques such as clicking and dragging. If you need more information 
about mouse techniques or working with disks, see the documentation that 
came with your Macintosh. 

 

What you need

 

To use FileMaker Pro, you need the CD-ROM disc (or the floppy disks, if 
you don’t have a CD-ROM drive) in the FileMaker Pro package and the 
following equipment and software.

 

Minimum hardware and software requirements

 

To install and use FileMaker Pro for Macintosh, you need the following 
minimum equipment and software:

 

1

 

any Macintosh, Power Macintosh

 



 

, or compatible computer running 
System 7 or newer (System 7.1 or newer recommended)

 

1

 

a hard disk and 4 MB of RAM (8 MB RAM recommended for 
680x0 Macintosh and required for Power Macintosh computers)

 

1

 

a CD-ROM drive or a floppy disk drive that can read 1.4-MB floppy disks

 

System 7 note

 

If you are using System 7.0 or 7.01, you must also install 
System 7 Tune up, version 1.1.1. System 7 Tune up is available from Apple 
Computer, Inc. or your Apple

 



 

 Dealer.

 

Memory settings

 

To see the minimum and preferred application memory 
settings for FileMaker Pro, select the FileMaker Pro application icon after 
installation and choose 

 

Get Info

 

 from the File menu. For information about 
adjusting the memory allocated to FileMaker Pro, see “Adjusting memory” 
on page 1-11.
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Networking requirements

 

To share files among users on a network, you can use AppleTalk

 



 

, IPX/SPX, 
or TCP/IP networking. You can use one of the following solutions to share 
files on a mixed Macintosh and PC network. 

See the documentation that came with your Macintosh or network software 
for more information.

 

Using MacIPX with AppleTalk

 

When you choose MacIPX for networking, you 
can still access your AppleTalk printers and AppleShare

 



 

 servers. MacIPX 
is used for networking FileMaker Pro files only.

 

If you are using a 68000 Macintosh

 

, such as a Macintosh Plus, Macintosh SE, or 
PowerBook

 



 

 100, you should use only the AppleTalk protocol. MacIPX and 
MacTCP have only limited support on these computers.

 

Before you begin

 

Before you begin the installation process, lock your FileMaker Pro disks and 
turn off virus protection and file sharing.

 

Lock the FileMaker Pro disks

 

To write-protect the 3.5-inch floppy disks, slide the tab in the upper-right 
corner of the disk so that the small “window” is open. The CD-ROM is 
already write-protected.

 

Turn off virus protection and file sharing

 

Virus protection utilities and personal file sharing can interfere with the 
operation of the FileMaker Pro Installer. Before you install FileMaker Pro, 
disable these system utilities and turn off file sharing.

 

Macintosh platform Windows platform

 

MacIPX version 1.2.1 IPX/SPX or compatible protocol 

MacTCP

 



 

 2.0.6 or later
or Open Transport 1.0.7 or later

Microsoft TCP/IP-32
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Installing FileMaker Pro

 

You must use the installation program to install FileMaker Pro—you can’t 
install the application by dragging files to your hard disk.

The FileMaker Pro CD-ROM contains information, such as additional 
templates and support information, that is not found in the disk set. If you 
have a CD-ROM drive, you should use the CD-ROM disc; you do not need 
to use the floppy disks. The floppy disks are included as a convenience for 
users who do not have CD-ROM drives. 

 

If you don’t have a CD-ROM drive

 

The floppy disks included with 
FileMaker Pro 3.0 contain the application and all the files you need to start 
working. 

 

Installing from the FileMaker Pro CD-ROM disc

 

To start the FileMaker Pro Installer:

 

1.

 

Disable virus protection and file sharing if you haven’t already. 

See “Turn off virus protection and file sharing” on page 1-2 for more 
information. 

 

2.

 

Insert the CD-ROM disc into your CD-ROM drive.

You see the disc’s window on your screen. If you see only the disc icon, 
double-click the icon to open its window.

 

3.

 

Double-click the file named “Start Here”.

 

4.

 

Follow the instructions provided on the screen to start the Installer.

 

5.

 

When you see the FileMaker Pro Installer welcome screen, click 

 

OK

 

.

You see the FileMaker Pro Installer dialog box.

 

6.

 

Follow the steps described in one of the following sections:

 

1

 

If you want to install all the available files, skip to “Easy installation” 
on page 1-4.

 

1

 

If you want to install a subset of the FileMaker Pro files, skip to 
“Custom installation” on page 1-6.

Double-click this icon
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Installing from the FileMaker Pro floppy disk set

 

Important

 

Because the CD-ROM contains additional templates and other 
information not available on floppy disk, you should install from the floppy 
disks only if you do not have a CD-ROM drive.

To start the FileMaker Pro Installer:

 

1.

 

Disable virus protection and file sharing if you haven’t already. 

See “Turn off virus protection and file sharing” on page 1-2 for more 
information. 

 

2.

 

Insert 

 

Disk 1

 

 in the floppy disk drive.

You see the disk’s window on your screen. If you see only the disk icon, 
double-click the icon to open its window.

 

3.

 

Double-click the FileMaker Pro Installer icon to start the FileMaker Pro 
Installer.

 

4.

 

Click 

 

OK 

 

to dismiss the FileMaker Pro Installer welcome screen.

You see the FileMaker Pro Installer dialog box.

 

5.

 

Follow the steps described in one of the following sections:

 

1

 

If you want to install all the available files, go to the next section, “Easy 
installation.”

 

1

 

If you want to install a subset of the FileMaker Pro files, skip to 
“Custom installation” on page 1-6.

 

Easy installation

 

Follow these steps to install the complete FileMaker Pro package on your 
hard disk. The Installer automatically installs the correct version for either 
680x0 Macintosh or Power Macintosh computers. 

 

Important

 

To install a subset of FileMaker Pro files, see the next section, 
“Custom installation.”

To install FileMaker Pro on your hard disk:

 

1.

 

If you have not done so already, start the Installer.

To do so, use the steps described in “Installing from the FileMaker Pro 
CD-ROM disc” on page 1-3 or “Installing from the FileMaker Pro floppy 
disk set” on page 1-4.

Double-click this icon
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You see the FileMaker Pro Installer dialog box.

 

1

 

If you don’t see the name of the hard disk where you want to install 
FileMaker Pro, click the 

 

Switch Disk

 

 button, which appears only when you 
have more than one volume mounted.

If you switch to a disk that isn’t a hard disk or is locked, the 

 

Install

 

 button 
is dimmed and the dialog box tells you why you can’t install onto that 
disk. 

 

1

 

To select the folder in which you want to install the FileMaker Pro 3.0 
Folder, click 

 

Select Folder

 

 and select the desired folder.

 

2.

 

Click 

 

Install

 

.

The Installer begins copying files. A dialog box tells you what the 
Installer is doing. 

You receive a message if the selected drive doesn’t have enough space. 
You can delete files in the Finder

 



 

 to make more room on the disk or 
choose not to install some files (like the tutorial or template files) by doing 
a custom installation. (See the next section, “Custom installation.”)

 

3.

 

Follow the instructions provided on the screen. Click 

 

Stop 

 

if you want to 
cancel the installation process.

After all the files are installed, a final dialog box tells you the installation 
on your hard disk was successful.

 

4.

 

Click 

 

Quit

 

 to leave the Installer.

 

5.

 

If you turned off virus protection and file sharing before installing, 
remember to turn them back on now.

Disk where FileMaker Pro
will be installed
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Custom installation

 

To install a subset of FileMaker Pro files on your hard disk:

 

1.

 

If you have not done so already, start the Installer.

To do so, use the steps described in either “Installing from the FileMaker 
Pro CD-ROM disc” on page 1-3 or “Installing from the FileMaker Pro 
floppy disk set” on page 1-4.

You see the FileMaker Pro Installer dialog box.

 

1

 

If you don’t see the name of the hard disk where you want to install 
FileMaker Pro, click the 

 

Switch Disk

 

 button, which appears only when you 
have more than one volume mounted.

If you switch to a disk that isn’t a hard disk or is locked, the 

 

Install

 

 button 
is dimmed and the dialog box tells you why you can’t install onto that 
disk. 

 

1

 

To select the folder in which you want to install the FileMaker Pro 3.0 
Folder, click 

 

Select Folder

 

 and select the desired folder.

 

2.

 

Choose 

 

Custom Install 

 

from the pop-up menu.

Disk where FileMaker Pro
will be installed



 

Installing FileMaker Pro

 

1-7

 

The dialog box lists the files you can install.

 

 

 

3.

 

Click the files you want to install.

 

4.

 

Click 

 

Install

 

.

The Installer begins copying files. A dialog box tells you what the 
Installer is doing. 

You see a message if the selected drive doesn’t have enough space for the 
files you select. You can delete files in the Finder to make more room on 
the disk or choose not to install some files (like the tutorial or template 
files) by deselecting those files in the scrolling list.

 

5.

 

Follow the instructions provided on the screen. Click 

 

Stop 

 

if you want to 
cancel the installation process.

After the selected files are installed, a final dialog box tells you the 
installation on your hard disk was successful.

 

6.

 

Click 

 

Quit

 

 to leave the Installer.

If you installed the MacIPX networking software, the final dialog box 
allows you to restart your computer. You must restart your computer 
before you can use the new network software.

 

7.

 

If you turned off virus protection and file sharing before installing, 
remember to turn them back on now.

Files you can install

Click here for 
information 
about the 
selected file

Total amount 
of disk space 
required for 
the selected 
files
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Where files are stored on your hard disk

 

The following table shows the files and folders you can install, and the 
preferred location for them on your hard disk. If you install onto the current 
system disk, the FileMaker Pro Installer places all the files you need in their 
preferred locations.  

 

 

 

 

 

File or folder Description Preferred location on hard disk

 

FileMaker Pro The FileMaker Pro 3.0 application FileMaker Pro 3.0 Folder

FileMaker Pro Help The FileMaker Pro onscreen Help system FileMaker Pro 3.0 Folder

FileMaker Pro Balloon Help The FileMaker Pro onscreen Balloon Help

 



 

 system FileMaker Pro 3.0 Folder

FileMaker Tutorial A FileMaker Pro file that introduces you to the main 
features of FileMaker Pro 3.0

FileMaker Tutorial folder in the 
FileMaker Pro 3.0 Folder

Template files Predesigned templates that help you use FileMaker Pro right 
away

FileMaker Templates folder in the 
FileMaker Pro 3.0 Folder

Example files Example databases that show you the advanced features of 
FileMaker Pro

FileMaker Examples folder in the 
FileMaker Pro 3.0 Folder

Apple Events Reference A FileMaker database that documents how to use Apple 
events with FileMaker Pro, and scripting examples and 
sample AppleScript

 



 

 and HyperCard

 



 

 applications

FileMaker And Apple Events folder 
in the FileMaker Pro 3.0 Folder

AppleTalk Network 
MacIPX Network
TCP/IP Network

Modules that support AppleTalk, MacIPX, and TCP/IP 
networks

FileMaker Extensions folder in the 
FileMaker Pro 3.0 Folder

ClarisWorks
DBF

ClarisWorks

 



 

 and DBF database translation filters FileMaker Extensions folder in the 
FileMaker Pro 3.0 Folder

Claris Help Viewer The application that accesses the FileMaker Pro 
Help file

Claris folder in your System Folder

US English - Spelling The primary dictionary of 100,000 words that 
FileMaker Pro uses to spell check your files

Claris folder in your System Folder

User Dictionary The dictionary that stores your customized list of spelling 
exceptions and additions to the US English - Spelling 
dictionary 

Claris folder in your System Folder 
(the Installer doesn’t install a User 
Dictionary if you already have one in 
your Claris folder)

Claris Spelling Enabler Software that enhances the performance of the Claris 
spelling engine

Claris folder in your System Folder 
(Power Macintosh only)

Claris Translators folder Translators that FileMaker Pro uses to read graphics files 
created in other applications

Claris folder in your System Folder

Claris XTND System Software that you use to open graphics in other formats Claris folder in your System Folder

MacIPX control panel, MacIPX 
AppleTalk, MacIPX Ethernet, 
MacIPX Token Ring

Control panel for configuring MacIPX, and MacIPX 
interface files. These files are installed only in a Custom 
installation.

Control panel in your Control Panels 
folder and remaining files in the 
Extensions folder in your System 
Folder
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Personalizing your copy of FileMaker Pro

 

The first time you start FileMaker Pro, you’re asked to supply your name, 
company name (if applicable), and software registration number. The 
information you type appears each time you start the application and in the 
dialog box that you see when you choose 

 

About FileMaker Pro

 

 from the Apple 
menu and click 

 

Info

 

.

To personalize your software:

 

1.

 

If necessary, open the FileMaker Pro 3.0 Folder by double-clicking its 
icon.

 

2.

 

Start FileMaker Pro by double-clicking the application icon.

You see the Personalize dialog box.

 

3.

 

In the 

 

Name

 

 box, type your name and press the Tab key.

The insertion point moves to the next box.

 

XTND enabler Extension that enhances the XTND graphics importing 
capabilities of Claris products

Extensions folder in your System 
Folder (Power Macintosh only)

 

File or folder Description Preferred location on hard disk

Application icon

Type your name here
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4. Type your company name, if applicable, and press Tab.

If you don’t have a company name, you can put other information (like 
your address) in the box or leave it blank.

5. Type the serial number from your FileMaker Pro registration card.

The serial number is optional, but Claris recommends typing it here in 
case you lose your registration card. You need the serial number if you 
call Claris Technical Support or Customer Assistance.

Check your typing carefully. After you click OK, you can’t change the 
name, company, or serial number unless you reinstall FileMaker Pro.

6. Click OK.

Now you can create a new database file or open an existing file. For more 
information on creating and working with FileMaker Pro documents, see 
the FileMaker Pro User’s Guide.

Registering with Claris
Take a minute to register FileMaker Pro in one of the following ways:

1 complete and mail the postage-paid product registration card

1 call (800) 356-6657 to register by phone

1 use the onscreen registration database by clicking the Register button in 
the New Database dialog box, which appears when you start 
FileMaker Pro. You can fax the completed registration card to Claris or 
send it by mail.

Keep the part of the registration card with your serial number on it in a safe 
place.
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Adjusting memory
The Macintosh sets aside a certain amount of memory for FileMaker Pro. 
However, you might need to change the amount of memory reserved for 
FileMaker Pro if you plan to:

1 work on a large database file

1 work on several database files at once

1 host database files

1 use a database file that contains many graphics

1 insert a large graphic into a database file

1 run several applications at the same time and you have a limited amount 
of memory (RAM) installed

For more information on managing Macintosh memory, see the 
documentation that came with your Macintosh computer.

Changing the amount of memory used
If you want to change the amount of memory reserved for FileMaker Pro, 
keep the following points in mind:

1 The amount of memory you give to FileMaker Pro affects your ability to 
run other applications. If the System and FileMaker Pro take up all the 
available memory, you won’t be able to open other applications. 

1 Avoid specifying less memory than the Suggested size in the 
FileMaker Pro Info dialog box.

To change the amount of memory FileMaker Pro uses:

1. If FileMaker Pro is open, quit the application by choosing Quit from the 
File menu.

2. In the Finder, open the FileMaker Pro 3.0 Folder and click the FileMaker 
Pro application icon.

Note If you click the application icon twice, you start FileMaker Pro. If 
that happens, choose Quit from the File menu and try again.
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3. Choose Get Info from the File menu.

You see the FileMaker Pro Info window.

4. In the Memory Requirements area at the bottom of the window, double-
click the Preferred size number and type a number to change the memory 
allocated for FileMaker Pro.

If you can’t type into the box, make sure you’ve quit FileMaker Pro.

5. Click the close box.

The next time you start FileMaker Pro, the amount of memory you 
specified is available for the application.

Change the amount of memory 
FileMaker Pro uses here
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Choosing a network protocol
You must choose a network protocol if you want to use FileMaker Pro over 
a network, either as a guest or as a host. For more information about your 
network, consult your network administrator.

Important The network protocol setting in FileMaker Pro must be the same 
on the host and guest computers. 

To choose a network protocol:

1. Choose Preferences from the Edit menu.

You see the Preferences dialog box. If necessary, click the pop-up menu 
at the top of the dialog box to choose General.

2. Choose a network protocol from the Network protocol pop-up menu.

Changes to this setting don’t take effect until you quit FileMaker Pro and 
then start it again.
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Opening files from previous versions 
FileMaker Pro 3.0 can open files from FileMaker Pro 1.x or 2.x for 
Macintosh and FileMaker Pro 2.x for Windows. To use files created with 
FileMaker Pro 1.x or 2.x, you must convert them to FileMaker Pro 3.x.

To convert and open a file:

1. Start FileMaker Pro 3.0.

2. Choose Open from the File menu and select the file you want to convert 
in the Open dialog box.

You see the conversion dialog box.

3. Type a name to rename the original file, or uncheck the Rename old file 
checkbox to retain the name of the file. 

The original file remains in the older format. 

After you click OK, you see another dialog box where you can name the 
file that will be created and saved in the new format. You cannot use the 
converted file with versions of FileMaker Pro earlier than 3.0.

4. Click Save to start the conversion.

FileMaker Pro converts the file and opens it.
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Where to go from here
After you install FileMaker Pro, you can immediately begin working with 
the application. Here are some suggestions on where to go in the 
documentation to get started:

1 If you’re new to databases, read chapter 1, “FileMaker Pro basics,” in the 
FileMaker Pro User’s Guide to learn basic database concepts.

1 If you’re new to FileMaker Pro, work through the online tutorial, which 
is automatically copied to your hard disk when you do an Easy Install.

1 If you’ve used FileMaker Pro before, read chapter 2 of this guide to find 
out about the new features available in FileMaker Pro 3.0.
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Chapter 2: New features in FileMaker Pro 

 

This chapter introduces the new features available in FileMaker Pro 3.0.

 

Relational database capability

 

FileMaker Pro 3.0 supports relational features that you can use to display the 
contents of a field from another database file. You can display records from 
the related file in a layout of the current file. 

A 

 

relational database

 

 is one or more discrete database files that contain all 
the data you need to do your work. In a relational database, each occurrence 
of data is stored in only one file at a time, but you can access and work with 
that data from any file.

For more information about relational databases, see chapter 10, “Using data 
from related files,” in the 

 

FileMaker Pro User’s Guide.

 

Improved networking

 

You can now use the Preferences dialog box to choose the network protocol 
that FileMaker Pro uses to communicate over a network. For more 
information about setting this preference, see “Choosing a network protocol” 
in chapter 1 of this manual.

FileMaker Pro now ships with TCP/IP support for Macintosh and Windows. 

In this relational database, the Customer layout displays invoices from the Invoices file. The 
two files are related by the Cust ID field.
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FileMaker Pro 3.0 can be used with FileMaker Pro Server 3.0 for enhanced 
performance and to allow up to 100 guests to share databases. FileMaker Pro 
Server 3.0 supports simultaneous AppleTalk, IPX/SPX, and TCP/IP 
networking with both Macintosh and Windows guests. Guests can use the 
protocol of their choice to network with FileMaker Pro. (AppleTalk 
networking is not available for Windows guests.) For more information, see 
the documentation provided with FileMaker Pro Server 3.0 (available 
separately).

 

Enhanced calculations

 

The enhanced user interface for defining calculations gives you easy access 
to more than 45 new and improved functions. In addition, you control when 
FileMaker Pro calculates the results, saving space in the database file. For 
more information about calculations, see “Understanding formulas” in 
chapter 2 of the 

 

FileMaker Pro

 

 

 

User’s Guide

 

.

 

ScriptMaker enhancements

 

With the new script steps available in the ScriptMaker

 



 

 feature, you can: 

 

1

 

control script execution (create If/Else and looping procedures, allow user 
abort, capture script errors)

 

1

 

manage windows (freeze or refresh windows, toggle or lock the status 
area, set the zoom level) 

 

1

 

manage data entry (paste the result of a calculation, set the contents of a 
field, perform a replace, revert the contents of a record)

 

1

 

dial phone numbers

 

1

 

show messages to the user

 

1

 

go to a related record or portal row 

 

1

 

and much more...

Scripts can now be executed when a file is opened and/or when a file is 
closed. You can use the 

 

Duplicate

 

 button to quickly duplicate scripts or script 
steps.

For more information about using ScriptMaker, see chapter 5, “Using 
ScriptMaker and buttons,” in the 

 

FileMaker Pro

 

 

 

User’s Guide

 

.
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Browse and Find mode improvements

 

You can now revert changes after you modify a record or a find request.

You can save space in a database file by storing graphics by reference. With 
this feature, you can store a graphic once but display it in many places 
throughout the database. 

FileMaker Pro now supports and works with empty found sets.

You can replace a field’s contents with other text, serial numbers, or a 
calculation result. 

For more information about these features, see chapter 4, “Working with 
information in records,” in the 

 

FileMaker Pro

 

 

 

User’s Guide

 

.

 

Editing enhancements

 

FileMaker Pro now supports “drag and drop” for text and graphics. You can 
use drag and drop to move objects within a field, between fields, and 
between files.

Additional text editing features allow you to:

 

1

 

insert tabs in fields and text objects

 

1

 

use a new text ruler to format text in fields and text objects

 

1

 

specify paragraph margins, indentation, and spacing above and below a 
paragraph (in addition to line spacing)

 

1

 

format text in text objects or fields on a paragraph-by-paragraph basis 

For more information about working with text and graphics on a layout, see 
chapter 3, “Laying out and arranging information,” in the 

 

FileMaker Pro

 

 

 

User’s Guide

 

.

 

Field definition improvements

 

With the new options for field definitions, you can:

 

1

 

use global fields to show the same value in every record

 

1

 

validate data entry by calculation or a value list

 

1

 

auto-enter a value from the previous record or based on the result of a 
calculation
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1

 

specify a custom validation message

In addition, you can define new storage options for text, number, date, time, 
and calculation fields. You can specify:

 

1

 

whether FileMaker Pro should always index the field, index the field 
when required, or never index the field

 

1

 

what language to use for indexing text

 

1

 

whether to store a calculated value or to calculate the value when it is 
required

For more information, see “Choosing data entry options” in chapter 2 of the 

 

FileMaker Pro

 

 

 

User’s Guide

 

.

 

More flexibility with value lists

 

Value lists are no longer attached to specific fields. This change means that 
one value list can be shared by several fields. In addition, you can base a 
value list on the contents of a field. 

You can now edit a value list:

 

1

 

during data entry

 

1

 

during layout design, even over a network

For more information, see “Defining value lists” in chapter 3 of the 

 

FileMaker Pro
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New options in Layout mode

 

New features in Layout mode allow you to:

 

1

 

insert the contents of a field into a text object on a layout using merge 
fields

 

1

 

define buttons more easily using a new button tool

 

1

 

edit the text within buttons or groups without having to ungroup or 
undefine the button

 

1

 

remove a layout from the Layout pop-up menu that appears in Browse 
mode

 

1

 

work with additional zoom levels

 

1

 

set custom page margins for your layouts
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1

 

use a new context pop-up menu to edit a selection in both Layout and 
Browse modes

Sample data in Layout mode now comes from your own records, so you can 
design your layouts more accurately.

Label layout creation has been simplified. The new interface avoids the need 
to use sliding.

For more information about layouts, see chapter 3, “Laying out and 
arranging information,” in the 
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More powerful file handling

 

FileMaker Pro file sizes are no longer limited to 32 MB. In addition, you can 
now have up to 50 database files open at the same time. For more 
information, see “Managing files” in chapter 1 of the 
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Automatic database creation

 

FileMaker Pro can automatically create a new FileMaker Pro database from 
a file created in another application. Simply open a file (such as a tab-
separated text file) in FileMaker Pro, and a new database file is automatically 
created, containing the fields from the original file, a Standard layout and a 
Columnar report layout, and the data. For more information, see “Importing 
data into a new file” in chapter 8 of the 
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Expanded import and export

 

New import and export features allow you to:

 

1

 

import and export in additional file formats

 

1

 

create field definitions while setting up an import

 

1

 

apply auto-entry options while importing data

For more information about importing and exporting, see chapter 8, 
“Importing and exporting data,” in the 
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New ways to limit user access

 

You can disable all or most of the menus using new access privileges, and 
you can disable the status area using ScriptMaker. For more information see 
chapter 7, “Networking and access privileges,” and chapter 5, “Using 
ScriptMaker and buttons,” in the 

 

FileMaker Pro

 

 

 

User’s Guide.



 

Appendix A: MacIPX control panel

 

You can use the MacIPX control panel to:

 

1

 

select the network interface for your MacIPX-based applications

 

1

 

change parameters that MacIPX uses (if necessary)

 

Using an Ethernet or token-ring network interface for MacIPX

 

The MacIPX control panel displays icons for the available network 
interfaces, such as Ethernet, AppleTalk, and token ring. MacIPX 
automatically configures itself for the first networking environment it 
detects when the Macintosh starts. 

 

AppleTalk users

 

For information on selecting an AppleTalk interface and 
related options, see “Using an AppleTalk interface for MacIPX” on page A-4”.

 

PCI Power Macintosh users (such as Power Macintosh 7200, 7500, 8500, 
9500)

 

These Macintosh models use Open Transport networking.

 

Warning

 

Be sure to use Open Transport version 1.0.7 or later.

To switch between network interfaces (Ethernet, token ring, or AppleTalk):

 

1.

 

Open the MacIPX control panel.

 

2.

 

Click one of the icons to select it.

The software on your computer system determines which icons you see.

MacIPX control panel

After you select the IPX
interface, the control panel

displays the network
number and node number
of your Macintosh on the

selected interface
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3.

 

Click 

 

OK

 

, and then close the MacIPX dialog box.

 

Note

 

MacIPX 1.2.1 supports most Ethernet interface cards, as well as the 
token-ring interface card from Apple Computer. 

 

Selecting a frame type

 

Each packet of information on the network must conform to a specific frame 
type to communicate with other devices on the network. After you select the 
network interface, you can let MacIPX select a frame type, or you can select 
one yourself. 

 

Note

 

All computers communicating with each other on the network must use 
the same frame type. If you have questions about your frame type, check 
with your network administrator.

To have MacIPX select the frame type:

 

1.

 

In the MacIPX control panel, double-click the selected network interface 
icon.

You see the Access Configuration dialog box for your chosen network 
interface. For example, if you click the Ethernet icon, you see the Ethernet 
Access Configuration dialog box, where you can set parameters for 
working with Ethernet.

 

2.

 

In the Access Configuration dialog box, click 

 

Always Auto-Configure Frame 
Type

 

.

The dialog box shows the
currently selected frame type
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3.

 

Click 

 

OK

 

 to close the dialog box.

When you start up your Macintosh, MacIPX determines the appropriate 
frame type by monitoring packets on the network. When this option is 
checked, the buttons for the frame types are unavailable.

 

Note

 

When IPX is using more than one frame type on a network, MacIPX 
might not choose the frame type you require. If, after configuring the 
MacIPX control panel, you are unable to connect to FileMaker Pro 
databases using the Network Access dialog box, you may have the wrong 
frame type selected for your network. Try turning off 

 

Always Auto-
Configure Frame Type

 

 and then select the appropriate frame type. Consult 
your network administrator if you have questions.

To select a frame type manually:

 

1.

 

In the Access Configuration dialog box, deselect 

 

Always Auto-Configure 
Frame Type

 

.

 

2.

 

Click one of the frame types, and then click 

 

OK

 

.

Choose from four frame types for Ethernet and two for token ring. Check 
with your network administrator if you’re not sure which frame type to 
select. 

When you close the dialog box, you see an alert dialog box. 

 

3.

 

Click 

 

OK

 

.

To have MacIPX determine the appropriate frame type at any moment: 

 

1.

 

In the Access Configuration dialog box, click 

 

Auto-Configure Frame Type 
Now

 

. Then click 

 

OK 

 

to dismiss the message.

In the dialog box, MacIPX highlights buttons in sequence until it 
determines the appropriate frame type.

 

2.

 

Click 

 

OK

 

 to close the dialog box.
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Using an AppleTalk interface for MacIPX

 

If your Macintosh is connected to an Apple LocalTalk

 



 

 network, you must 
specify an AppleTalk interface to use MacIPX networking. When you use 
AppleTalk, you must also select an IPX gateway.

 

Important

 

Novell supplies MACIPXGW.LAN, a LAN driver (IPX gateway) 
that can be run on Novell NetWare v3.11 or later servers, which lets you use 
AppleTalk to share information with other computers on the IPX network. 
Contact your Novell dealer or use an online service to get this driver. To 
install the LAN driver on your Novell server, see your Novell system 
administrator or the documentation that came with the driver.

To select an AppleTalk network interface:

 

1.

 

Open the MacIPX control panel.

The MacIPX control panel is installed in the Control Panels folder inside 
the System Folder.

 

2.

 

If necessary, click the AppleTalk icon to select it and then click the close 
box.

Your Macintosh then sends IPX packets encapsulated in AppleTalk, 
which are delivered on the LocalTalk network to an IPX gateway. The 
gateway decapsulates these packets and routes them over an IPX network. 
See the following steps for information on selecting a gateway.

To have MacIPX select an available IPX gateway: 

 

1.

 

In the MacIPX control panel, click the selected AppleTalk icon. 

You see the AppleTalk Access Configuration dialog box.
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2.

 

In the AppleTalk Access Configuration dialog box, choose an AppleTalk 
zone that has an IPX gateway.

 

3.

 

Click 

 

Always Auto-Select an IPX Gateway from the Selected Zone

 

.

 

4.

 

Click 

 

OK

 

 to close the dialog box.

When the Macintosh starts up and detects that it’s connected to an 
AppleTalk networking interface, such as LocalTalk, it selects an 
appropriate IPX gateway in the specified zone. In some cases (for 
example, if you get an error message), you need to select the gateway 
yourself.

To select an IPX gateway yourself:

 

1.

 

In the AppleTalk Access Configuration dialog box, deselect 

 

Always Auto-
Select an IPX Gateway from the Selected Zone

 

.

 

2.

 

Choose an AppleTalk zone where an IPX gateway is installed. 

When you click a zone name, you see a list of available IPX gateways. 

 

3.

 

Click an IPX gateway. 

 

4.

 

Click 

 

OK

 

 to close the dialog box.



 

A-6

 

FileMaker Pro Installation & New Features Guide

 

Setting advanced MacIPX parameters

 

From the MacIPX control panel, you can set other parameters that affect 
MacIPX operations. 

 

Important

 

Only a certified network engineer or administrator should change 
the advanced parameters. Changing the parameters without a good 
understanding of their functions can adversely affect the performance of 
MacIPX. For more information, see your network administrator or contact 
your Novell dealer.

To set advanced parameters:

 

1.

 

In the MacIPX control panel, click 

 

Advanced Options

 

.

You see the MacIPX Parameters dialog box.

 

2.

 

Set the parameters you want and click 

 

OK

 

 to save your changes. You must 
restart your computer for the changes to take effect.

 

Note

 

To restore the parameters to the default settings provided by Novell, 
click 

 

Restore Defaults

 

 and restart your system. If you make changes to the 
settings and want to restore the parameters to what they were when you 
opened the dialog box, click 

 

Cancel

 

. 

Click to reset the
default values
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Use the information in the following tables to set parameters for:

 

1

 

MacIPX 

 

1

 

SPX (Sequenced Packet Exchange)

 

1

 

SAP (Service Advertising Protocol)

 

1

 

RIP (Routing Information Protocol)

For the following SPX parameters, you can enter any value between 0 and 
9999. The values for 

 

Abort Timeout

 

, 

 

Listen Timeout

 

, and 

 

Verify Timeout 

 

apply 
only to those SPX connections using the “watchdog,” such as those used by 
FileMaker Pro 3.0 

 

MacIPX parameter Function

 

Disable IPX 
Diagnostic Services

Disables the IPX Diagnostic Services, used by some network 
management tools. Disabling IPX Diagnostic Services can reduce the 
amount of memory that MacIPX uses. Click this parameter if you 
don’t use any network management tools, or if your tool doesn’t use 
IPX Diagnostic Services.

Maximum Network 
Packet Size

Limits the maximum network packet size. The value can’t be greater 
than the maximum value supported by the physical network. Enter 0 
(zero) to let MacIPX determine for itself what value to use.

Enable IPX 
Checksumming

Enables checksumming of IPX packets. The option is unavailable if 
the current network doesn’t support IPX checksumming.

 

SPX parameter Function

 

Abort Timeout Sets the amount of time that SPX waits, without receiving any response 
from the other side of the connection, before it terminates the session. 
The timeout number is expressed in ticks (with 60 ticks per second). 
The default value is 2400 ticks, or 40 seconds.

Listen Timeout Sets the time that SPX waits, without receiving a packet from the other 
side of the connection, before it requests the other side to send back a 
packet assuring that the connection is still valid. If SPX hasn’t heard 
from the other side of the connection within this time, it sends packets 
to the other side asking for verification that the connection still exists. 
The default value is 1200 ticks, or 20 seconds.

Verify Timeout Sets the frequency at which SPX sends a packet to the other side of a 
connection to inform it that its side is still active. If no packets are 
being exchanged on the SPX connection by the software that 
established the session, SPX sends packets at regular intervals to make 
sure that the connection is still working. The default value is 480 ticks, 
or 8 seconds.

Default Retry Count Specifies the maximum number of times that SPX attempts to 
retransmit a packet before determining that the packets can’t be sent, 
and then closes the connection. The default value is 10 times. An 
application can override the value in this field.



 

A-8

 

FileMaker Pro Installation & New Features Guide

 

For the following SAP parameters, you can enter any value between 0 and 
9999, but an application can override the values you set.

For the following RIP parameter, you can enter any value between 0 and 
9999.

 

Minimum Retry Count Specifies the minimum number of times that an SPX packet must be 
retransmitted. If an application has a retry count setting that is too low, 
you can override it by setting this parameter. The default value is 0 
(zero) times.

 

SAP parameter Function

 

Query Interval Specifies the time that must elapse before an SAP query is 
retransmitted. The default value is 120 ticks, or 2 seconds.

Query Attempts Specifies the number of times that an SAP query is transmitted. The 
default value is 3 times.

Receive Buffers Specifies the number of buffers to handle responses returned from SAP 
queries. The default is 20 buffers.

 

RIP parameter Function

 

Retry Interval Specifies the time that must elapse before a RIP request is 
retransmitted. The default value is 0 ticks, which lets the MacIPX 
determine what the interval should be, based on the network 
configuration.

 

SPX parameter Function


